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Required Responsibilities 

 

This Advanced Oracle training will only be useful to those Dallas County employees that have 
Oracle access.  The following table outlines the level of access to Oracle that management must 

provide to you to answer the specific question or perform the specified task.  

 

TO PERFORM OR ACCESS: YOU WILL NEED THE MINIMUM 
RESPONSIBILITY LEVEL OF: 
 

Funds Available GL Inquiry 

 

How much a department has spent (general fund) AP Inquiry 

 

How much a department has spent (other funds, 
grants, projects) 

 

AP Inquiry/ GL Inquiry 
 

Budget encumbrances PO Inquiry 

 

PO/ Requisition Details PO Inquiry 

 

Employee Reimbursement AP Inquiry 

 

Vendor Payments AP Inquiry 

 

 

 

Frequently Asked Questions (FAQ) 

What is an account code combination? 
The cornerstone of financial reporting hinges upon the understanding of the elements of the Dallas 

County Account Code Combination. 

 

This is what the account code combination could look like: 

00120.1070.02170.0000.0000.00000.00000.0000  
 

This is what it represents: 

Fund.Department.Account.Year.Program.Project.Grant.Future 

(1) (2) (3) (4) (5) (6) (7) (8) 

 
Each group of numbers is called a segment. 

1.  Fund – Texas county government utilizes fund level accounting so all reporting is by fund.  

Some funds also represent bank accounts. 

2.  Department – Represents a full department and/or business unit within a department where 

detailed financial reporting is needed.   

3.  Account - Account numbers represent different types of activity like expenses and revenues or 
accounting instruments such as assets, liabilities & payroll.   

4.  Year - Currently this is used in conjunction with Project and Grant segments and will contain 

the fiscal year that grants were awarded or projects were started.  For example the same grant can 

be awarded every year or every two years and financial reporting must be sensitive to the award 

period.   

TIP: Prior to Fiscal Year 2007 the County followed the practice of using the current 

fiscal year for all combinations.      



Dallas County Auditors Office Oracle Advanced Topics 

 

 

Created 8/2008 4 Updated: 04/2016 

 

5.  Program - Program number represents a special program or a program related to a project.   

When this segment contains the word ―Prog‖ that means that the account combination is a 

summarization of other accounts.  

6.  Project – Project Numbers for projects or 00000 
7.  Grant – Grant number for Grants or 00000 

8.  Future – Reserved for future use currently always 0000 

 
 

Exercise: Using DC GL Inquiry execute report request ―Chart of Accounts - Segment Values 
Listing‖ to see what is available for each segment type above. 

 

What is an accounting period?  
A Dallas County accounting period is a calendar month however it is on the fiscal year calendar.  

The format is MON-FY-YY    

MON = Calendar month…  JAN, FEB, MAR…OCT, NOV, and DEC 

FY is a constant and does not change 

YY = Fiscal Year   
 

When use to indicate the end of a report criteria OCT-FY-14 would include the date 10/31/2013 

because a new fiscal year starts in October. 

 

 

What is my department’s budget, how are we doing? 
  

General Operations: 
Determination of financial status for departmental financials can be accomplished by using the 

following formula.  

 
(Fiscal Year to Date) Funds Available = Budgeted – (Actuals + Encumbrances) 

    

Funds Available:  Term used to describe remaining expendable budget. 

Fiscal Year to Date:  Describes the time frame relevant to determining operational budget. 

Measures from October 1st to the current period specified. 

Budgeted: Established annually at the beginning of the fiscal year, October 1st, these amounts 
would be the allotment for spending during the course of the year.    

Actuals:  This reflects the actual funds applied to an account that would indicate actual funds 

paid to a vendor. 

Encumbrances:  Encumbrance is a promise to pay usually related to expense accounts.  At Dallas 

County funds are encumbered when a requisition has been approved. 
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Escrow Operations: 
Escrows are monies that belong to some-other entity that is being collected or managed by Dallas 

County.  Escrows differ from each other and persons monitoring escrows must understand the 

rules that apply to their specific escrow.  

 

Generally the determination of financial status for Escrow financials can be accomplished by using 

the following formula.  
 

(Project to Date) Funds Available = (Escrow Contributions/Liability + Revenue) – (Actual        

Expenses + Encumbrances) 

 

Escrow Contributions/Liability:  This is where funds are kept before they are sent to their 

owners.   
Project To Date:  This means that amounts are the sum of monies since creation.  There is no 

specific begin date. 

Revenue:  Funds brought into the County from the outside. 

 

Tip:   Budgets are still used to support purchasing rules but have no impact on supporting escrow 
reporting. 

 

 
Grant Operations: 
Grants are funded periodically and have a specific period of time for those funds to be used.  The 

timeframe is typically not in line with the County’s fiscal year and is identified by the year 
segment.  However, Grant funds available are rolled forward each fiscal year, funds available 

reporting will work the same as general operations by using the following formula.  

 
(Fiscal Year to Date) Funds Available = Budgeted – (Actuals + Encumbrances) 

    

There are several tools available to review financial information and a number of them will be 

discussed shortly. 

Budget Analysis Web Report 

Each month the Auditor’s Office publishes a budget analysis report online at the County website.  

You can locate Budget Analyses by going to the Financial Transparency page either from Auditor’s 

home page or from Transparency menu on the Dallas County home page.  This is usually available 

5+ days after the end of the month. 

 
OR you can type the following path into your web browser. 

http://www.dallascounty.org/department/auditor/budget_analysis.html 

 

Click on the Excel icon for the desired year 

and month.  If the report has not been 
published the website will not prompt you 

with a download option. 

 

Once you have downloaded the report you 

will have to navigate the tabs within the 

spread sheet to get to information meaningful 
to you. 

 

Tabs are ordered by Fund 

Number/Department Number.  Section totals 

and Grand totals are available for each 
column. 

https://www.dallascounty.org/departments/auditor/budget-analysis.php


Dallas County Auditors Office Oracle Advanced Topics 

 

 

Created 8/2008 6 Updated: 04/2016 

 

 

Column A:  Expense Category, Expense account numbers and descriptions 

Column B:  Current Month Expenditures (for that report)  

Column C:  Encumbrances, Amounts that have been obligated but not yet paid 
Column D:  YTD Actual + Encumbrance, Year to date Expenditures + Column C (Encumbrances) 

Column E:  PCT of Budget, percent of allocated budget already used (―D‖/‖F‖). 

Column F:  YTD Budget, budget amount as of that month.  (Budgets may adjust during the year) 

Column G: Remainder of Budget, amount available to you through the rest of the fiscal year. 

  

 

 
Budget - Funds Available Analysis Report  

 

The Budget - Funds Available Analysis Report provides totals by account and account type for 

budget, actual and encumbrance amounts allowing for the calculation of available funds.  
Parameters allow for further control over grouping and totaling. Knowledge of the accounting 

structure at Dallas County and this report will allow a person to look at budget status from various 

angles.   

 

This single Request can be executed using the responsibility DC GL INQUIRY.    

DC GL INQUIRY  Report  Run.  Select ―Single Request‖ the click ―OK‖. Type ―Budget‖ and 
click the ―Tab‖ key. Select ―Budget-Funds Available Analysis‖ 
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In the Parameters screen fill in your parameters for:  

1. Page Break Segment:  Provides the highest level of summarization and a range can be applied 

to reduce the volume of the report. The account segment is already handled by the report so 
choose one of the remaining 7 segments. (see account combinations)  

2. Lower Page Break Range: Must provide a range for the page break segment parameter.  (The 

report will return page totals for each unique value within the range.) 

3. Higher Page Break Range: Must provide a range for the page break segment parameter  

4. Secondary Segment:  Provides grouping and totals within each unique value of the page break 
segment. 

5. Account Type:  The report is a summary of accounts you can limit your report to a specific 

account type or choose X for all accounts.  

6. Budget = Select a specific budget you are reporting on. (FY#### is the active/working budget, 

LAB#### is the legally adopted budget)  The period name is linked to the chosen budget. 
7. Period Name:  Select a Month and Fiscal Year. This would represent the last reporting period 

included on the report.   SEP-FY-2014 would represent an end date of 09/30/2014.   

8. Report Type:   

 Year-to-Date-Extended (YTDE).  This will return information from October 1st to period 
name specified.  This will work for most reporting needs gives you the year-to-date values 

plus carry forward from prior years.   

 Project-to-Date (PJTD) should be used target lifetime actuals and encumbrances.  
Especially useful when targeting grant awards and projects.  The budget and the funds 

available should be ignored.    

 Period-to-date (PTD) will only give you the totals of what occurred within the period 
selected.  Consider it a snap shot.  The actual amounts will be populated, budget and 

encumbrances may be populated, and funds available will usually be negative and should 

be disregarded.  

 Quarter-to-date-extended (QDTE) works like period-to-date targeting the quarter identified 
by the period selected and ending with the period selected. 

 Encumbrance Type  = All (recommended) 

 Summary Template is not currently used at Dallas County. 
 

Features: 

 Grouping of the report is Page Break Segment (Range)/Secondary Segment/Accounting Type.  

Account totals are the lowest level of detail displayed on the report. Totals occur at each 
grouping level and grand totals are also provided. 
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 The titles on each page will tell you parameters selected and which Page Break Segment value 
is currently being addressed.   

 The first column manages the Secondary Segment and will contain a value only when the 
Secondary Segment value changes. 

 The A/C column manages the account type and will be populated when the account type 
changes.   Each account type identified by the account type parameter is represented even if 

the value is zero.   
 

Reporting Examples:  Can you tell the class what is being asked for with these parameters?   

General Operation:  1) Department 2) 5210 3) 5210 4) Fund 5) X 6) FY201# 7) Current month 8) 

YTDE     

 

 
 
Escrow Operation:  1) Project 2) 94084 3) 94084 4) Fund 5) X 6) FY201# 7) Current Month 8) PJTD  
Grant Operation:  1) Grant 2) 09384 3) 09384 4) Year  5) X 6) FY201# 7) Current Month 8) YTDE     
Grant Award Details:  1) Grant 2) 09384  3) 09384 4) Year  5) X 6) FY201# 7) Current Month 8) PJTD  

 

(Use the Copy function to re-use the prior report execution) 
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How do I see the details?    

Funds Available Inquiry 

Want to look for funds available without sifting through a report?   Perhaps you want to drill down 

to the activity that impacts the funds available?  Use the Funds option under the GL Inquiry 
menu.   It allows you to research the summary accounts that are used for funds checking relating 

to purchasing and requisitioning.     

 

1. Choose Amount Type – Year to 

Date Extended  

2. Choose the current budget   
3. Choose the current period to get 

up to the second available funds 

4. Account Level = Detail. 

5. Click under Account in the grid 

to enter Account Range 
Fund:00120 Dept:5210  Year 

0000  (Ranges left blank will 

return all values)   

6. Click [OK] 
 

The Account grid works the same way on several 

inquiries so we will cover a few of its features 

here:  

 The Account section will be updated with all 
available accounts that match the criteria 

specified whether they have activity or not. 

 Click on different account lines.  
Notice that the account 

description changes as do the 

encumbrance breakdowns.  

 To change the account search 

criteria click under the Account 
column to set focus and click 

Find Icon and the Find Account 

pop up will be returned to you. 

 

7. Change the Account range From 
01999  To 03999  

 

Why do some of the accounts have negative funds available?   Dallas County uses a control that 

allows related accounts to be individually over budget as long as the sum does not exceed funds 

available.  This control is a summary account.  

 
Summary Accounts:  Summary accounts 02001 (Operational) & 08001 (Capital) are used for 

funds checking.  Account ranges that make up the summary groups can be found by running the 

―Chart of Account – Rollup Range Listing‖ 

 

Closed periods are 
final.  Open periods 

can except changes 

  5 
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8. Change Account Level to Summary  

9. Navigate to the ccount column when 

the Find Account pop-up appears 

remove the To and From Account 
and click OK.  
What is different about this account? 
In this example how much does this 
deparment have availble to spend 
from their opertional budge? 
 

The rest of this section will focus on how to use the Tools Menu to drill 

down to the specifics behind these stats.  Highlighted options can be 

selected and this will change as you navigate. 

 
What accounts make up the Capital Summary account? 
 

10. Highlight the Capitol summary account => Tools Menu => Detail Accounts.  This action will 

display in a new window the accounts within this Summary account. 

 
How can I see what 
makes up the 
Encumbrance and 
actual amounts? 

 

11.  Highlight the account of interest and Tools Menu => Period Balances 

 
Period Balances will show you a 

month by month snapshot of what 

has happened.  You can look at 

period balances at the account or 

the summary level.     
 

12. Select a period and use the Tools 

menu to drill down to the specific 

journals that make up the 

displayed statistic.  This displays 

the Accounting Detail screen. 
13. Highlight a specific line and click 

―Drilldown” to see what transactions 

in initiated the journal entry.  If the 

Drilldown button is not enabled this is 

most likely a manual journal entry.  
The ―Journal” button can let you see 

the original journal in its entirety.    

 

From this screen make 
sure the line you are 

interested in is selected 

and click the View 

Transaction button. 
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GL Account Inquiry  
 

What if you need to see what happened from one date to another and funds available was your 

focus.  If you wanted to find out what you spent from your ―Office Supplies‖ account?  

    

Return to the Navigator window and choose Account.  The Account query lets you examine 
various aspects of a single or set of combinations for a single or set of financial periods.  

Note: Before clicking on ―Account‖, go to ―Tools‖ and uncheck ―Close Other Forms‖. 

 

1. Choose one or more Accounting Periods.  Notice that the ―To‖ date will change when the 

―From‖ date is changed.  This may not be expected behavior.  
 

 
2.  Primary Balance Type:  Select Actual 

3. Put your cursor in the first Accounts line and click Find icon.   Enter the ―Office Supplies‖ 

account from General fund and Health Administration department.  
4. Click OK.  

 

"Show Balances”:  Shows totals for each period within the range. 

 

“Show Journal Details”: Shows all journal entries for the entire period range. 
 

You can also choose [Journal Details] from the Show Balances screen and see the journal entries 

for that specific period. 

Let’s look at the Journal Detail.  

 

 Did you know you can export these journal entries into Excel? 
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The Source column tells you how the entry made it into Oracle.  Manual indicates that 
independent journal entries were made and Payables means that journals were created from the 

accounts payable process usually from an invoice. 

 

Place your cursor on a line with the source of Payables.  Note that the [Drilldown] button 

activates.  This allows you to navigate to the invoice within AP that parented this journal entry.  

From there you can see the purchase order, supplier and detail information about the invoice. 
 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 
 

 

 

 

 

 
 

Manual 
Entry 
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Click [Show Full Journal] to see more about how information got to the GL (try one marked 

Manual Entry).  

 

 
Entries are placed into the GL in something called journal batches.   

 
For applications like AP that feed the GL these journal batches can be quite large. 

 

You can use the Query/Find features to look for a specific entry.  

 

 

  Note: when using wildcards, the account must use the Decimal placeholders and you 

cannot exceed the segment size. 

i.e.  %.02160.% would return the entry targeted from the journal details. 

Wildcards are symbols that represent one or more characters where the values are not known, 

often used in search related functions.   
 

Notice when AP journals verses manual journals are selected, the ―Drilldown‖ button is available.   

Look at budget and encumbrance data for the same period.    
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DC General Ledger Report (180 characters) 
 
Use responsibility DC GL Inquiry and the DC General Ledger Report (180 characters) to see all 

journal activity for a single or set of account combinations.   The advantage of using the General 

Ledger is that it includes applicable corrections via manual journal entries. 

 

 
 

Enter the Parameters as shown above.   
 Type   

o Document Number:  Shows the sequence number of journal containing your journal line.  
o Entry Item:  Will show the external reference field from the journal entry headers 
o Line Item:  Shows Reference _1 from the Lines table (Journal import) 
o Source Item: Shows Reference_4 from the Lines table (Journal import) and is most commonly used. 

 Balance Type 
o A – Actual 
o E - Encumbrance  
o B – Budget 

 Starting and Ending Periods: only allow Month and Fiscal Year selection. 

 Account From and Account To:  Designate desired account code combination range.  You will need to fill out all 

segments. 
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What is an Encumbrance?   
Funds are encumbered (similar to being set aside now to ensure availability for a future obligation) 
through Requisitions and Purchase Orders.  Departments obtain goods and services through the 

Requisitions process in Oracle.  The Requisition must be approved, and assigned to a Dallas 

County Buyer who creates a Purchase Order for the selected supplier.   

Encumbrance Detail Report 

Navigate to DC PO INQUIRY. Select Requests —> Run —> Single Request.  Click OK. 

The Name of the report is Encumbrance Detail Report. (NOT DC Encumbrance Detail)  Click OK. 

Click the “Tab” key in order to fill in the eight (8) segments.  
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In the Parameters screen fill in your parameters for:  

 Title =  Leave Blank (Click the ―Tab‖ key to access the eight segments form) 

 Cost Center From/To = Leave Blank 

 Encumbrance Date From/To = Leave Blank 

 Everything else can be left blank 
 

Click OK 

Submit 
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Requisitions become Purchase Orders (PO) 

To find out if a requisition has successfully gone through the approval process and resulted in a 
Purchase Order use the following steps: 

 

Navigate to DC PO INQUIRY— Purchase Order Summary.  In the Find Purchase Order screen 

click on the Related Documents tab.   Enter your Requisition Number, or use the LOV button to 

locate the number.  Click Find.   The Purchase Order number, description, quantity, amount, and 

Approval Status are displayed in the Purchase Order Distributions screen. 
 

 
 

The PO Number would be on the next screen and you can scroll to the right for the PO Status 
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Conversely, if you had the Purchase Order number, but needed to know more about the 

Requisition: 

 
Navigate to DC PO INQUIRY— Requisitions Summary.  On the Related Documents tab enter 

your PO Number, or use the LOV button to locate the number.  Click Find.    

 
 

The Requisition Lines Summary provides the Requisition number, description, quantity, amount, 
Requester name, Need-By date, and location.  

 
Use the Tools menu to go back to related Purchase Orders. 
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View Purchase Order Details 
 
Navigate to DC PO INQUIRY— Purchase Order Summary. 

 

 
 

Entering the PO number and clicking on Find is the quickest way to PO details.  However this 

search screen has some fairly unique features.   

 
The tabs allow you to expand additional search criteria on the Purchase Order. 

Selecting a button in the Results section will control what is returned: 

 Header: Ship To (Department), Supplier name, Amount, Approval Status, Order Date, and 
Buyer. 

 Lines:  Item Category (Hint Ctrl+E will provide code details) Description, Quantity, Price, 
Amount, Unit of Measure, and Buyer. 

 Shipments: Shipment Amount, Quantity, Quantity Due, Quantity Received, Quantity 
Accepted, Quantity Billed, Quantity Cancelled, and Matching Type  

 Distributions: Shows the same things as the Line information, but also shows the account 
code combination in the Charge Account field. 

 

This might be helpful when PO have multiple lines. 
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*What happened to my Employee Reimbursement?  
 

Navigate to DC AP INQUIRY  Invoices  Inquiry  Invoices.    

 

Search by name (%Last name%First name% format), or invoice number (the last date of travel 
in the MM-DD-YY format), or the amount owed (no commas or dollar signs), pertinent dates (DD-

MM-YYYY), or any combination of the above.   Click Find. 
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At the bottom of the screen, click on tab #4 to View Payments.   Values are: Payment Method, 

Document Number, Payment Date and GL Date fields indicates that the payment has been made. 

 

 
If the Date or Payment information is blank, click on tab #5 to view Scheduled Payments. 

(EX: Name:%ROBERT%SABRI% Invoice Number: %040616%) 

 

Has this Vendor been paid? 
 

Navigate to DC AP INQUIRY  Invoices  Inquiry  Invoices.       

Search by Supplier name, and/or invoice number, amounts or dates (if known). 
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The Invoices screen will provide the Invoice Date, Number, Amount, Description, GL Date, Payment 

and Method (check/other). 

 

Find Versus Query 
 

Oracle Applications provides you with easy-to-use search capabilities to access application 
information. You can quickly retrieve and review all available information in your database without 

having to remember the information displayed in windows, or print lengthy reports to see the data. 

Instead, you can simply run a query to obtain the information you want and review the data online 

in the same window used to enter the data. 

 
Navigate to DC AP INQUIRY  Invoices  Inquiry  Invoice Batches 

 

View/Find:  If you want to query for records in your current block or window, the simplest way to 

proceed is to use Find.  Find displays a window that lets you specify search criteria.  A Find 

window contains fields for entering search criteria that are specific to the current block and often 

validate the search criteria you enter against a list of valid values. 
 

 
 

Find is user friendly, allows for entry by specific information (not case sensitive), text string with 

wildcard (%) or LOV (where it is available).   Find fields, however, limit the search criteria. 
(EX: Names: %CANAS%ROBERT%, Dates: 01-DEC-15)  

 

 

 

 
 

 

 

 



Dallas County Auditors Office Oracle Advanced Topics 

 

 

Created 8/2008 23 Updated: 04/2016 

 

Query-by-example:  If you want to retrieve a group of records based on more sophisticated search 

criteria than what Find allows, you can use a feature called query-by-example, under View. As an 

expert user you can use query-by-example to specify complex search criteria in any of the fields, or 

multiple fields of your current block. The search criteria to help you pinpoint the specific data of 
interest can include: 

 specific values,  

 phrases containing wildcard characters, and/or  

 phrases containing query operators  
 

HINT:  The query field is case sensitive.  The first letter is usually capitalized 

 

 
EX: Date >01-JAN-15, Invoice Type: ―Standard‖ 

 

Direct entry windows: View/ Query by Example/ Enter (OR F11 key) allows direct entry into 
fields to help retrieve records of interest.  If a field allows queries, the color will change from tan to 

light blue.  Scrolling to the right reveals all available fields.   

 

Menu Shortcut Keys Function 

View->Query by 

Example-> Enter 

[F11] Sets the data form in Enter Query 

mode.  At this point search criteria 

can be entered. 

View->Query by 

Example-> Run 

[Ctrl] + F11 Executes the Query and depending on 

entry results will be return and data 
entry mode is turned on. 

View->Query by 

Example-> Cancel 

[F4] Returns form to data entry mode 

without performing query. 

 [F4] Ends/Cancels current activity.  Can 

also be used to exit forms, etc. 

 [F12] Returns the record count only based 

on entered query.  Count will be 

displayed on the message line. 
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EX:     If >01-JUN-08 is in the date field, and the control amount query is for amounts greater  

 than $1,000, than only records for amounts both over $1,000 and dated after June 1st  

 are returned.   
 

Query is a powerful tool that renders nearly every entry field into a search field using the following 

operators:   

 

Operator  Meaning  Example Expression  

=  equals  = 'Tshibamba', = 107  

!=  is not  != 'Daniel', != 109  

>  greater than  > 99.1, > '01-JAN-04'  

>=  at least  >= 55  

<  less than  < 1000.00  

<=  at most  <= 100  

#BETWEEN  between two values  #BETWEEN 1 AND 1000  

% Wildcard STAP% 

 

Remember:  Query by example is independent from any previous filtering criteria like previous 

searches.     

 
Attention: In Enter Query mode, all check boxes are initially in a null state. To use a check box as 

a search criterion, you must explicitly check or uncheck it. 
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How to Change Screen Appearance Using Folders? 
 

A folder block is a special block whose layout you can customize. The following helps you 

distinguish a folder block from a regular block. 

1. An enabled Folder menu appears in the main menu bar when your cursor is in a folder 

block. 
2. An enabled Folder Tools button appears on the toolbar when your cursor is in a folder 

block. 

3. An Open Folder button appears in the upper left corner of a folder block. 

 

 

 

 
 

 

1 

3 

2 
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Creating a custom folder 
When you first sign-on to Oracle Applications and navigate to a folder block, what you see is the 

original default folder or a folder defined by your system administrator.  

 

You can customize a folder block's layout, create query criteria to retrieve just a subset of records, 

display those records in a different layout and save your customizations as a folder.   
You can create, save, and open folders as well as delete folders that you have created.  

You can modify this default folder and save your customizations to be the new default.  When you 

open a new folder, the layout for the new folder simply replaces the layout for the current folder. 

 

A custom default folder can be distinguished from the original default folder -- a custom default 
folder always displays its name next to the Open Folder button.   

 

Before creating a custom folder, you should save the original default folder by giving it a 

unique name.  This enables opening the original folder by choosing it from a list of predefined 

folders. 

 
To Save a Folder: 

 

Navigate to DC AP INQUIRY  Invoices  Inquiry  Invoice Batches 

1. Select ―Save As…‖ from the Folder Menu to save the current folder under a new name.  

2. Complete the Folder Name (ORIGINAL FOLDER) and Autoquery (Never) information 
requested in the Save Folder window.  

3. Click OK. 

 

 
Figure 1 
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To Create a New Folder: 

 

1. Select New from the Folder Menu. 

2. The Save Folder popup appears (See Figure 1 above) 
3. Enter a new Folder Name. 

Note: The name must be unique.  

4. Mark an Autoquery option:   

 Always --- Automatically queries for a subset of records each time you open 
the folder.  This option is not recommended as it may slow the 

system response. 

 Never --- Does not query   

 Ask each time --- Opens the decision when the folder is opened. Click Yes to 
query. 

Never should be the option if you are just formatting the screen.   

Ask should be the option if you are wanting to force a query by example. 

5. Select ―Open as Default‖ to make this new folder open as your default each time you 

navigate to this folder. 

6. Select ―Public‖ if you want other Oracle Applications users to have access to this folder.  
(Others can use this folder, but only you can modify it.) 

Note: If you modify a public folder, saving it makes it a private folder.   

7. Click OK when you are done. 

 

The name that you assign to this folder appears in the upper left corner of the folder block next to 

the Open Folder button, whenever you open this folder.   
 

 
  
To Open Another Folder: 

 

1. Select Open from the Folder Menu or click the Open Folder icon next to the folder name  

2. Select a folder from the list window that appears. 

3. Click OK to replace the current folder with the new folder. 
You can see all available folders, including the original default folder that you saved.   

 

To Recover the Original Default Folder: 

 

If you have created a new folder and made it the default, the original default folder can be 

recovered by performing these steps. 
  

1. Select Save As from the Folder Menu when you are in the custom default folder. 

2. Unmark the ―Open as Default‖ in the Save As window that appears. 

3. Click the OK button when you are done. 

4. Close and reopen the form to display the original default folder. 
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To Save Changes to a Folder: 

 

1. Click Save on the Folder Menu to save any layout or query changes made to the current 

folder. 
Note: If you save a folder to "Open as Default", then open another folder and save that 

second folder also as "Open as Default", the second folder becomes the new default. 

 

 To Delete an Existing Folder You Created: 

 
1. Select Delete from the Folder Menu. 

2. Select a folder from the list. 

3. Click OK to delete the folder. 

Note: You can only delete folders you have created.  If there are any pending changes to 

the information in the folder, you will be prompted to save the changes or cancel the 

delete.  If another user is referencing the folder as their "Open as Default" folder, 
their reference will be deleted. 

Changing a Folder Layout 
 

The Folder Menu and Folder Tools provide you with many options to help you customize your 

folder layout.   

 

To Hide a Field: 
 

1. Select Hide Field from the Folder Menu or select the Hide Field icon from the Folder Tools 

to remove the current field from the folder layout.   

Note:  Your cursor moves to the next field. Some fields cannot be hidden. 

 

 
 

To Show a Hidden Field: 
 

1. Select Show Field from the Folder Menu or select the icon from the Folder Tools. 

2. Select a value from the list. 

3. Click OK to display the field in the folder layout. 

Note: The new field is inserted after the current field, and the cursor moves to the new 

field. 
 

To Widen or Shrink the Width of a Field: 

 

1. Select Widen Field or Shrink Field from the Folder Menu or Folder Tools.  

Note: This increases or decreases the width of the current field.  

 
 

 

 

 

 

Hide 

Show 

Shrink 

Widen 
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To Move a Field to the Right or Left: 

 

1. Select Move Right or Move Left from the Folder Menu or Folder Tools. 

Note: This swaps the position of the current field with the field to its right or left, in a 
multi-record block, or moves the current field one character-width to the right or 

left, in a single-record block. 

 

To Autosize All the Fields of a Folder: 

 
1. Select Auto size All from the Folder Menu. 

Note: This resizes displayed fields based on a sample of values for the field in the 

block, ensuring that no field is smaller than the width of it's prompt.  

 

To Rename a Field Name (Prompt): 

 
1. Select Change Prompt from the Folder Menu, or right click on the name(prompt). 

2. Enter a new prompt name in the Alter Prompt window.  Select Default, to recover the 

original prompt name for the field. 

3. Click OK.  

 

Saving Folder Search Criteria 
 

A main advantage of a folder block is that you can customize it to display only the records you 

want to see.  You can easily alter the query criteria for a folder and save the criteria with a 

folder.  You can also control the sorting order of the records you display in a multi-record 

folder. 

 

To Define Query Criteria for a Folder: 
 

1. Run the query you want, either by using Query Find or Query-by-Example. 

2. Select Save As from the Folder Menu if you want to save the query criteria in a folder. 

3. Enter a name for the folder. 

4. Select the Autoquery Option Group.  

 Always The query will be automatically performed each time you open 
the folder.  

 Never The query will be saved with the folder, but will not 
automatically run when you open the folder.    

 Ask Each Time  Will be prompted when you open the folder to decide if you 
would like the query to be performed immediately.  

5. Click the OK button when you are done. 

 

Notes:  
 When you save a folder, the query criteria remains with the folder.   

 When you perform another query on that same folder, your new query will only be 

performed on the subset of records retrieved by the folder.   

 If you want to perform a new query-by-example on the complete set of records, you need 

to first reset the query for the folder definition before performing another query. 
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To View the Query Criteria for a Folder: 

 

1. Select View Query from the Folder Menu. 
 

To Reset the Query Criteria for a Folder: 

 

1. Select Reset Query from the Folder Menu.   

2. Perform another query. 
3. Click Save from the Folder Menu to save the new query to your current folder. 

 

To Alter the Sorting Order of Data in a Multi-Record Folder: 

 

1. Select Sort Data from the Folder Menu.   

2. Click the drop down arrow to switch any one of three settings:  

 Ascending -- sorts the column in ascending order. 

 Descending -- sorts the column in descending order. 

 No Order -- does not sort the column. 
3. Click OK to sort the query in your folder to apply any changes of ordering to the 

records. 

4. Clicking on the column name (prompt) reverses the order immediately. 

5. Select Save or Save As from the Folder Menu to save this query criteria and layout.  

 

Example:  Suppose you want to create a folder definition called ―Unposted‖ Batches in the 
Journal Entry folder block of your Oracle General Ledger application. You want this folder 

definition to automatically display unposted batch records.  

 

1. Go to the Batch Status field (if it is not already displayed choose Show Field from the 

Folder menu}.  
2. Hit the F11 key or choose Enter from the Query menu to perform a query-by-example.   

3. Enter the value Unposted (first letter is capitalized) in the Batch Status field 

4. CTRL + F11 or choose Run from the Query menu to retrieve all unposted batch records. 

 

Choose Save or Save As from the Folder menu to save this query criteria and layout. Enter a 

unique name to identify the folder. Make sure to set the Auto Query option group to the desired 
behavior.  

Hint: Change responsibly to DC GL INQUIRY. 

 

 

 
 

 

 

 

 

 
 

 

 

 

 
 

 

 

 


